# Table of Contents

Introduction ........................................................................................................................................... 3
Install.................................................................................................................................................... 3
  Download the Guest .......................................................................................................................... 6
  Install the Guest .................................................................................................................................. 8
  Download the Host ............................................................................................................................... 10
  Install the Host .................................................................................................................................... 13
Guest ....................................................................................................................................................... 16
  Load and Unload the Guest ................................................................................................................. 16
  Impero Guest functionality .................................................................................................................. 16
Host ........................................................................................................................................................ 17
  Start and stop the Impero Host Daemon ............................................................................................. 17
  Display and hide the Impero Host window ......................................................................................... 18
  Host Functionality .............................................................................................................................. 19
Uninstall .................................................................................................................................................. 20
  Uninstall the Guest ............................................................................................................................. 20
  Uninstall the Host ............................................................................................................................... 21
Introduction

The following guide is intended to guide the user in how to install, uninstall, load and unload Connect on Linux.

Connect for Linux includes the Guest and Host.

The Guest can connect to a remote Host through the following communication protocols:

- Impero Portal
- Internet (TCP)
- LAN (TCP)
- WebConnect and WebConnect3

The Host uses the following communication protocols to connect to the Guest:

- Impero Portal
- Internet (TCP)
- LAN (TCP)
- UDP
- HTTP
- WebConnect and WebConnect3

Install

Before you install the Host and Guest, make sure that your computer meets the following minimum technical requirements:

Supported platforms: 32 & 64-bit

- Red Hat Enterprise Linux 7
- Ubuntu 16.04, 18.04, 20.04
- SUSE 12
NOTE: Supported X Window System is X.org

Memory:
- For the Guest a minimum of 1 GB (2 GB recommended)
- For the Host a minimum of 512 MB (1 GB recommended)

Disk space:
- For the Guest a minimum of 410 MB
- For the Host a minimum of 45 MB

Video: any supported by X.org Server

NOTE: To be able to install the Host or Guest, make sure that the user logged on the computer has system user privileges.

To download the Connect for the supported Linux distributions refer to the following link.
- The download page includes separate installation or archive files for the Guest and Host depending on your Linux distribution.
- The archive file contains the following files:
  - ca-certificates.crt
  - eula.txt
  - install.pl
  - installpubkey
  - Impero.pub
  - Impero-*-deb | Impero-*-rpm (based on the Linux distribution in use)

install.pl is a Perl script file that handles the installation process via the terminal.
To list all the parameters of the `install.pl` Perl script, use the following command:

`install.pl --help`

`install.pl` parameters table:

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>[--help]</td>
<td>Prints the help message and exits.</td>
</tr>
<tr>
<td>[--version]</td>
<td>Prints the version info and exits.</td>
</tr>
<tr>
<td>[--serial &lt;serial&gt;]</td>
<td>Installs the Guest</td>
</tr>
<tr>
<td>[--debug]</td>
<td>Turns debugging on.</td>
</tr>
<tr>
<td>[--license]</td>
<td>Prints the License.</td>
</tr>
<tr>
<td>[--autoinstall]</td>
<td>Non-interactive installation assumes that you agree with the License.</td>
</tr>
</tbody>
</table>

**Example:**

For the non-interactive Host installations, use the following command:

`perl install.pl --autoinstall --host <serial>`
You can install the **Guest** and **Host** in two ways:

A. You double-click on the `Impero-host_*.deb` | `rpm`, and `Impero-guest_*.deb` | `rpm` installation file within your desktop environment.

B. Install them from the terminal.

**NOTE:** We recommend that you install the **Guest** and **Host** via the terminal.

### Download the Guest

You can download the **Guest** from:

- the Portal
- the Impero website, by clicking on the following link

To download the **Guest (Support Console)** application from the **Portal**, proceed as follows:

1. Log in the **Portal**.
2. Go to the **My Devices** page.
3. Click on the **Download Guest (Support Console)** button.

4. Select the desired platform from the dropdown menu.

5. Save the archive.
Install the Guest

A. Install the **Guest** through the Software Install*

To install the **Guest** through the application software, proceed as follows:
1. Go to the file path of the extracted **Guest**.
2. Double click on the **Impero-guest_*.deb | rpm** installation file. The following window is displayed.

![Image of installation window](image)

3. To install the **Guest**, click on the **Install** button.
4. Specify your password for authentication.

B. Install the **Guest** via the terminal*

To install the **Guest** via the terminal, proceed as follows:
1. Go to the file path of the extracted **Guest**.
2. Open up a terminal window.
3. Use the following Perl script to initiate the installation process:
   ```
   sudo perl install.pl
   ```
   ![Image of terminal output](image)

   Specify the password for authentication.

* The procedure applies to Ubuntu version 18.04.1 distribution of Linux.
4. As part of the installation process, it is necessary that you accept the **End User License Agreement**.

5. Specify the type of license you want to use for the **Guest**. The following options are available:
   - **Portal** – all communication happens using the **Portal** (a **Portal** account is required)
   - **Trial** – a 15-day fully-featured trial
   - **Custom** – specify the required license after buying the product
**Guest** installed successfully.

**NOTE:**
- You are prompted to specify a license key.
- If you do not specify a license key, **Guest** automatically installs itself in **trial** mode.

**Download the Host**

You can download the Guest from:
- the Portal
- the Impero website, by clicking on the following [link](#)
To download the **Host** application from the **Portal**, proceed as follows:

1. Log in the **Portal**.
2. Go to the **My Devices** page.
3. Click on the **Add device** button.
4. Select the **Host** for another operating system option from the dropdown menu.

![Host selection](image)

5. Select the **Host** for the desired platform.

![Host selection](image)

6. Save the archive.
Install the Host*

**A. Install the Host via the Software Installer**

To install the Host via the Software Installer, proceed as follows:

1. Go to the file path of the extracted **Host**.
2. Double click on the **Impero-host_*_.deb | rpm** installation file. The following window is displayed.

![Screenshot](image)

3. To install the **Host**, click on the **Install** button.
4. Specify the password for authentication.

**B. Install the Host via the terminal**

To install the **Host** via the terminal, proceed as follows:

1. Go to the file path of the extracted **Host**.
2. Open up a terminal window.
3. Use the following Perl script to initiate the installation process:
   
   `sudo perl install.pl`

---

* The procedure applies to Ubuntu version 18.04.1 distribution of Linux.

* The procedure applies to Ubuntu version 18.04.1 distribution of Linux.
4. As part of the installation process, it is necessary that you accept the **Acceptable Use Policy.**

5. Specify the type of license you want to use for the **Host.** The following options are available:
   a. **Portal** – all communication happens using the **Portal** (a **Portal** account is required)
      i. Specify if you have a **Portal** account.
ii. Specify the enrollment key for your Portal account.

b. Trial – a 15-day fully-featured trial.
   i. Specify if you have a Portal account.
   ii. Specify the enrollment key for the Portal account.

c. Custom – specify the required license after buying the product.
   i. Enter the License key for the Host.

**NOTE:**
- You are prompted to specify a license key.
- If you do not specify a license key, Host automatically installs itself in Trial mode.

ii. Specify if you have a Portal account.
iii. Specify the enrollment key.
Guest

Load and Unload the Guest

To load the Guest, execute the following command in a terminal window:

```bash
Imperoguest
```

To unload the Guest, click on Exit from the File menu.

Impero Guest functionality

To connect to another port number than the Impero default port 6052, add the port number to the Host name or address after a colon, for example, 192.168.100.1:1234.
Host

**Host** includes the following programs:

- **Impero Host Daemon** (*Imperohostd*) - The **Impero Host Daemon** runs when the computer operating system starts. A user with system user privileges can start and stop the **Impero Host Daemon**.

- **Impero Host Program** (*Imperohost*) – The **Impero Host Program** loads and starts when the **Impero Host Daemon** loads. If started, the communication is initialized enabling a **Impero Guest** to connect. A user can typically control the **Impero Host Program** from the **Impero Host GUI**.

- **Impero Host GUI** (*Imperohostgui*) – The **Impero Host GUI** displays the **Impero Host** graphical user interface. It does not automatically load when the **Impero Host Program** loads. A user can load and unload the **Impero Host GUI**.

**NOTE:** Only a user with system privileges can make changes to the **Impero Host** program options.

Start and stop the Impero Host Daemon

The **Impero Host Daemon** starts and stops with the Linux operating system. A user with system user privileges can start, stop and report the status of the **Impero Host Daemon** with the following terminal window commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/etc/init.d/Imperohostd start</td>
<td>Start</td>
<td>You use this command to start the <strong>Impero Host Daemon</strong> and load the <strong>Impero Host Program</strong>.</td>
</tr>
<tr>
<td>/etc/init.d/Imperohostd restart</td>
<td>Restart</td>
<td>You use this command to restart the <strong>Impero Host Daemon</strong> and load the <strong>Impero Host Program</strong>.</td>
</tr>
<tr>
<td>/etc/init.d/Imperohostd status</td>
<td>Status</td>
<td>You use this command to return a message of whether the Impero Host Daemon is running or not.</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>/etc/init.d/Imperohostd stop</td>
<td>Stop</td>
<td>You use this command to unload the Impero Host Program and stop the Impero Host Daemon.</td>
</tr>
</tbody>
</table>

Display and hide the Impero Host window

The Impero Host GUI doesn’t automatically load when the Impero Host Program loads. If the Impero Host Program is loaded, execute the following command in a terminal window:

Imperohostgui

The Impero Host interface is displayed.

**NOTE:** The Imperohostgui command assumes that the Impero Host GUI program file is located in the /usr/bin directory or is located in a directory included in the global PATH. If the Impero Host GUI is located in another directory then specify the full directory path before the Imperohostgui command.
To unload the Impero Host GUI, click on Exit from the File menu.

**Host Functionality**

The Host window contains most of the Host for Windows window elements but has reduced functionality in comparison with the Windows version and the set up is organized differently.

The Host enables a remote Guest to connect by using the TCP/IP, TCP/IP (TCP), Serial (modem), HTTP, WebConnect, WebConnect3, and the Impero Portal communication protocols. Once authenticated, the Guest can view the remote screen, control the keyboard and mouse, transfer files between the computers, and interact with the end-user.

To change the setup options of the Host, click on Options on the toolbar or from the Tools menu. The Impero Host Configuration login window is displayed.

Specify a valid Linux username and the matching password.

**NOTE:** To change the setup options, make sure that you have the privileges to edit the /var/opt/Impero/host/host.xml file.
Click on **OK**. The **Impero Host Manager** is displayed.

Uninstall

**Uninstall the Guest**

To uninstall the **Guest**, either use the operating system’s package or as root execute the following commands in a terminal window:

- For **RedHat, CentOS, SUSE**:
  
  ```bash
  rpm -e Impero-guest
  ```

- For **Ubuntu**:
  
  ```bash
  sudo apt autoremove Impero-guest
  ```
Uninstall the Host

To uninstall the **Host**, either use the operating system’s package manager or as root execute the following commands in a terminal window:

- For **RedHat, CentOS, SUSE**:
  
  ```
  rpm –e Impero-host
  ```

- For **Ubuntu**:
  
  ```
  sudo apt autoremove Impero-host
  ```

Refer to the specific package manager of your distribution that you are using for more information on how to remove the installed packages.